
Model #: 111026 
Lit. #:  98-0828/07-10

Instruction 
Manual Version 2.0





3

WARNING

Do NOT look directly at the sun through your binoculars.
Doing so may cause permanent eye damage.

NOTE: To reset the camera if you experience problems or if the display becomes 
unresponsive, remove the batteries for at least one minute, then re-install them. 
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Congratulations on your purchase of the Bushnell ImageView® binocular! 
The Bushnell ImageView binocular takes the technology of digital 
photography and combines it with a high-quality compact binocular.  
This allows you to observe sporting events, wildlife, scenic vistas or 
anything you would normally use a binocular for, and then save the 
image in a built-in attached digital camera.  You can then download these 
images to your computer and e-mail them to your friends and family, 
print out the pictures, or save them in a photo album for future use. 
Before using the product, please read the instructions contained in this 
manual and take time to familiarize yourself with the different parts and 
features of the product.
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CAMERA PARTSSetup and Basic Operation
the camera is powered by two AAA alkaline, lithium, or NiMh batteries (not 1. 
included). insert batteries into the compartment, with the springs in contact with 
the negative (flat) end of each battery. A power meter on the left center of the 
display indicates battery condition.
insert an SD card ("upside down" with metal contacts facing up) in the slot if greater 2. 
storage is desired. You may use SD cards (not MMC cards) up to 8 GB capacity.  
Press and hold the MODE button until the camera turns on. the camera will turn 3. 
off automatically after about one minute if no buttons are pressed. Note: when the 
camera is connected to a computer via the supplied USB cable, the camera will power 
on automatically, and draw power from the computer with no battery drain.
Hold the imageView steady and press SNAP to take a picture (or start/stop 4. 
shooting a video, when the camera is in video mode). the camera focus is preset 
to take sharp photos from appoximately 35 feet to infinity.
When using a tripod, you can help avoid the effects of camera shake by plugging 5. 
the supplied remote shutter release into the jack next to the SD card slot, and 
using the button on the remote rather than SNAP to take photos.
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Setting Date & Time/ Using the Operational Modes
the imageView will imprint the date and time in the bottom right corner of your photos. 
to set the current date and time, after turning on the camera, press and hold both the 
MODE and SNAP buttons at the same time, until the display begins to flash. the display 
now shows the last two digits of the year. Press the MODE button to move the cursor to 
the second digit if necessary. Press the SNAP button to advance the digit to the current 
year ("10" for 2010, etc). then press MODE to go to the next number, which is the month. 
Again, use SNAP to change this to the current month. Following the month display is: 
date, hour (24hr format), and minute-continue to set these following the same process 
using the MODE and then SNAP buttons. When you have completed all of the date/time 
settings, the display will stop flashing and return to normal.  Note that you will need to 
reset the date/time after replacing batteries.

Your imageView is already setup to produce high quality results right out of the box, 
and it is not necessary to use the MODE settings and make any changes to get good 
results by simply pressing the SNAP button to take photos. However, as you might want 
to shoot a video clip, delete one or more previous photos, or explore other options, 
we recommend you review the available mode options listed on the following pages. 
Briefly pressing the MODE button will step through these operational modes in the 
listed order, and you will see the icon for each mode along with its current setting on 
the display. Use the SNAP button to select the desired setting for any mode. if you make 
no changes, and the SNAP or MODE button is not pressed within 5 seconds, the camera 
will return to normal operation and display. 
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Mode Icon Settings Description

Video Video 
Camera

OFF, High 
(640x480 
pixels per 
frame, 29 fps), 
Low (320x240 
pixels)

Select "Hi" (recommended) or "Lo" video 
resolution instead of "OFF" to put the camera in 
video mode. Wait a few seconds for the camera to 
automatically return to the normal display, then 
begin shooting by pressing SNAP. the counter 
will show the elapsed time while recording the 
video clip. Press SNAP again to stop shooting. the 
counter will advance by one, indicating the video 
file has been saved. Return to the video mode 
setting and select OFF to reset the camera to still 
photo mode. 

Quality Hq or Lq High, Low Select "Hi" (recommended) or "Lo" quality to 
choose the amount of file compression, which 
affects the size of the photo file. "Lo" allows more 
photos to be stored in memory, but at reduced 
quality.

Resolution Hi or Lo High (2.0MP*), 
Low (1.3 MP)
*via software 
interpolation

Select "Hi" or "Lo" resolution, based on your 
preference for more detailed photos (Hi) or being 
able to take a greater number of photos (Lo).

Using the Operational Modes  (Bold indicates default settings)
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Mode Icon Settings Description

Line 
Frequency

60 or 50 60 Hz, 50 Hz Set to match the AC power frequency (cycles) of 
your country. this ensures that stills and videos 
shot under fluorescent lighting appear normal.

Continuous Ct OFF, 3, 5 Select 3 or 5 frames to shoot a rapid series of 
photos instead of a single frame when SNAP is 
pressed (in normal still photo mode). to cancel, 
enter this mode again and select OFF.

Memory 
Access

MEM Sto (USB Mass 
Storage), PC 
(USB Camera)

Select "Sto" to access the SD card files when the 
camera is connected to a computer with the USB 
cable. "PC" allows the camera to be used as a live 
USB/PC camera (note that the 8x magnification 
and lack of close focus capability limits usefulness 
in most size rooms.)

Delete Last LSt+trash 
Can

None-press 
SNAP to delete 
the last photo 
or video

Select this mode and press SNAP to delete only 
the last photo or video you took. the counter will 
go down one number.

Using the Operational Modes
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Mode Icon Settings Description

Delete All ALL+trash 
Can

None-press 
SNAP to delete 
all photo and 
video files

Select this mode and press SNAP to erase the 
entire memory contents (the counter resets to 
zero). Use this after downloading your files, to 
clear the memory so you can take new photos. if 
"Delete All" is selected accidently, simply wait a 
few seconds and the camera will return to normal 
operation.

Format FOr+trash 
Can

None-press 
SNAP to 
format card 
or internal 
memory

if you are using a new SD card, or one previously 
used in other devices, we recommend you select 
Format and press SNAP before you start taking 
photos, to the card is setup with the correct data 
file system for this camera. Note that formatting a 
card  erases its contents-please be sure you have 
backed up any previous files first.

Self-timer Clock OFF or On Photo is taken after a 10 second delay when SNAP 
is pressed (in normal still photo mode.) this can be 
used to avoid accidently shaking the camera when 
the SNAP button is pressed. if the remote shutter 
cable is available, it should be used instead of the 
self timer when the camera is tripod mounted. 
the timer automatically cancels after use.

Using the Operational Modes
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Using the ImageView with Your Computer
the camera will be recognized as a USB mass storage device, which means no special 1. 
drivers are required for all operating systems later than Windows 98 (Me, 2000, XP, 
Vista.) Mac OS 9 and OSX are also compatible. 
if you have a computer OS as listed above that is USB mass storage compliant, a 2. 
new disc icon will appear in Windows Explorer (under “My Computer”) as a new 
“Removable Disc” after plugging in the USB cable from the imageview. Mac users will 
see the new disc device appear on their desktop. Clicking on the new disc icon will 
show the contents, a folder named “DCiM.” the image folder inside this contains your 
photos, stored as JPEGs (.jpg file format). they may then be viewed, edited, renamed 
and saved using any photo or graphics software that accepts .jpg files. 
After you have copied or opened and saved the photo files to your computers hard 3. 
drive, you may disconnect the imageview camera (NEVER disconnect the camera 
while files are still being transferred to your computer.) Before disconnecting, you 
should “eject” or stop the "removable disc" representing the camera to avoid an error 
message (not necessary with Windows XP or later OS). 
See the following pages for full step by step instructions to download your photos.4. 

System Requirements
Operating System: Windows® 2000/ME/XP/Vista/Windows 7 (Windows 98 is not 
supported) or Mac OS 9 / OS X
internal USB Port
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Connect the supplied cable to the imageView’s USB port, then directly to a main 1. 
USB port on your computer-do not use front panel/keyboard USB ports or unpow-
ered “hubs”.
the LCD display will indicate “StO”2. , and the imageView will be recognized as a 
standard “USB Mass Storage” device. this means that the camera files can be easily 
viewed, edited, or copied to your hard drive, just as if they were stored on an 
external hard drive or a CD-ROM. (Note for Mac users: you may need to select "StO" 
memory access and plug in the imageView while its LCD still displays "StO" for it 
to appear on the Mac desktop as an "Untitled" disk. See "Using the Operational 
Modes")
(3. This step is not required with recent Windows operating systems, simply use the 
options in the pop-up window to view, copy or edit your photos). Open My Computer 
or Windows Explorer. the camera will be seen as a new “Removable Disk” with an 
unused drive letter assigned to it. Double click this new “Disk” icon, open the “DCiM” 
folder inside, then the folder(s) inside that (“100MEDiA” ,etc). Your photos/videos 
are the files inside-they have the prefix “SUNP” followed by a 4-digit number, as 
seen earlier on the camera’s display when you review photos. Single clicking any 
file should show a small preview image.

Downloading the Photo/Video Files
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Downloading the Photo/Video Files
Click “Edit>Select All” (or click on one photo, contol+click to select multiple 4. 
photos), then “Edit>Copy to Folder” (in Windows menus). Select an existing folder 
on your hard drive, such as “My Pictures”, or create a new folder (“Hawaii Vacation”, 
etc), then click “OK” to transfer copies of the photo files you want.
After the photos are transferred to your hard drive, you can disconnect the camera. 5. 
Windows 2000 may produce a screen warning that you have disconnected a USB 
device without stopping or ejecting the “disk” first (your photo files will not be 
harmed). if so, check the box that adds an icon to your system tray or taskbar.  then 
next time you finish transferring photos, you can click that icon first, and “Stop the 
USB Mass Storage Device” before disconnecting the camera. (On Mac computers, 
you should “eject” the untitled “disk” that appeared on your desktop when the camera 
was connected.)
You’re now ready to open the photo files in any photo editing software. Just use 6. 
File>Open and go to the folder where you stored the photos earlier. it is also 
possible to open and work with your photos directly from the imageView while it 
is still connected. if you choose to work this way, from a connected camera, be sure 
that you save the photo (when you are done editing) to your hard drive, and not the 
camera’s memory or card. if you are new to photo editing on a computer, consult 
your software’s Help menu for tips on using its features. Along with adjusting the 
brightness, contrast, sharpness and color of your photos, you can resize the photo 
to fit the paper if you are printing, or save a smaller, low or medium resolution 
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Downloading the Photo/Video Files
version for email or inserting into documents. When you are ready to save your 
edited file, you may want to use “Save As” and give it a more descriptive name than 
“SUNP___”. Doing this also preserves the original file as a backup to reopen and re-
edit later.  Make sure you have successfully transferred all the photos you wanted 
to save before using “Delete All” on your camera to make room for new images.

Binocular Instructions
Your Bushnell binocular is a precision instrument designed to provide many years 
of pleasurable viewing. this portion of the booklet will help you achieve optimum 
performance by explaining how you can adjust the binocular to your eyes, and how to 
care for this instrument. Read the instructions carefully before using your binocular.

EYE ADJUSTMENTS (Figure 1)
How to Adjust For Distance Between Your Eyes
the distance between the eyes, called “interpupillary distance,” 
varies from person to person. 
to achieve perfect alignment of lens to eye, follow these simple 
steps:

Hold your binocular in the normal viewing position.1. 
Grasp each barrel firmly. Move the barrels closer together or further apart until you 2. 
see a single circular field. Always re-set your binocular to this position before using.

Fig. 1

iNtERPUPiLLARY DiStANCE
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Binocular instructionsHow to Adjust For Individual Eye Strength
As individual eyesight varies from one person to another, most Bushnell binoculars have a 
diopter setting feature which allows you to fine-tune the binocular to your vision. Follow 
the focusing instructions below for your type of binocular.

FOCUSING
Adjust interpupillary distance. (1. Figure 1)
Set the “diopter setting” (2. Figure 2) to zero and view a distant object.
Keep both eyes open at all times.3. 
Using a lens cover or your hand, cover the objective (front) lens of the same side of 4. 
the binocular that has the “diopter setting.” this is usually the right side. (the left side 
on zoom models.)
Using the center focus wheel, focus on a distant object with 5. 
fine detail (e.g., brick wall, tree branches, etc.) until it appears 
as sharp as possible.
Uncover the objective lens on the diopter side, cover the 6. 
other objective lens, then view the same object.
Using the “diopter setting” adjustment ring, focus the same 7. 
object being viewed. Caution should be used as over turning 
or forcing the diopter eyepiece can cause damage or cause the eyepiece to break 
away from the chassis.
Your binocular should be adjusted for your eyes. Focus at any far or near distances 8. 
can now be attained simply by turning the center focus wheel. Make a note of the 

DiOPtER SEttiNG

Fig. 2
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diopter setting for your eyes for future reference.

EYECUPS (Figure 3)
Your Bushnell binocular is fitted with rubber roll-down eyecups designed for your 
comfort and to exclude extraneous light. if you wear sun/eyeglasses, roll down the 
eyecups. this will bring your eyes closer to the binocular lens thus providing improved 
field of view.

Storage, Cleaning And General Care
Your Bushnell binocular will provide years of trouble-free service 
if it receives the normal care you would give any fine optical 
instrument. the imageview is not waterproof, and should not be 
exposed to any source of moisture. Water damage is not covered 
by the warranty.

if your binocular has roll-down, flexible eyecups, store it with the eyecups up. this 1. 
avoids excessive stress and wear on the eyecups in the down position.
Avoid banging and dropping.2. 
Store in a cool, dry place.3. 
WARNiNG: Looking directly at the sun with your binocular can cause permanent eye 4. 
damage.
Never expose your imageView binocular to any type of excessive liquid or fluid, as it 5. 
is not water/fogproof.

ROLL-DOWN EYECUPS

Fig. 3
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take the batteries out of your imageView if you are not going to use it for a long 6. 
period of time. 

CLEANING
Blow away any dust or debris on the lens (or use a soft lens brush.)1. 
to remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular 2. 
motion. Use of a coarse cloth or unnecessary rubbing may scratch the lens surface 
and eventually cause permanent damage. A “microfiber” cleaning cloth (available at 
most photo dealers) is ideal for the routine cleaning of your optics.
For a more thorough cleaning, photographic lens tissue and photographic-type 3. 
lens cleaning fluid or isopropyl alcohol may be used. Always apply the fluid to the 
cleaning cloth – never directly on the lens.
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Your Bushnell® product is warranted to be free of defects in materials and workmanship for two years after the date of purchase. 
in the event of a defect under this warranty, we will, at our option, repair or replace the product, provided that you return 
the product postage prepaid. this warranty does not cover damages caused by misuse, improper handling, installation, or 
maintenance provided by someone other than a Bushnell Authorized Service Department.

Any return made under this warranty must be accompanied by the items listed below:
 1) A check/money order in the amount of $10.00 to cover the cost of postage and handling
 2) Name and address for product return
 3) An explanation of the defect
 4)  Proof of Date Purchased
 5)  Product should be well packed in a sturdy outside shipping carton, to prevent damage 
  in transit, with return postage prepaid to the address listed below:

 IN U.S.A. Send To:    IN CANADA Send To: 
 Bushnell Outdoor Products   Bushnell Outdoor Products
 Attn.:  Repairs    Attn.:  Repairs
 9200 Cody    25A East Pearce Street, Unit 1
 Overland Park, Kansas 66214   Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable warranty information. 
in Europe you may also contact Bushnell at:     Bushnell Germany GmbH 
       European Service Centre 
       Mathias-Brüggen-Str. 80 
       D-50827 Köln 
       GERMANY 
       tel: +49 221 995568-0

       Fax: +49 221 995568-20

this warranty gives you specific legal rights. 
You may have other rights which vary from country to country.

©2010 Bushnell Outdoor Products

TWO-YEAR LIMITED WARRANTY



FCC Note:
this equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. these limits are designed to provide reasonable protection 
against harmful interference in a residential installation. this equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. if this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.•	
increase the separation between the equipment and receiver.•	
Connect the equipment into an outlet on a circuit different from that to which the receiver •	
is connected. 
Consult the dealer or an experienced radio/tV technician for help.•	

the shielded interface cable must be used with the equipment in order to comply with the limits for 
a digital device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change without 
any notice or obligation on the part of the manufacturer. 



©2010 Bushnell Outdoor Products

For further questions or additional information please contact:

Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214

(800)	423-3537		•		www.bushnell.com


